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Overview

» Release date 12.0
» May 2019

» Supported network technologies
» CAN & CAN FD, LIN, FlexRay, MOST, J1708, Ethernet, WLAN

» Options
» Smart Charging - CANoe @

AMD/XCP - CANoe

Car2x

Scope for CAN & CAN FD, LIN, FlexRay

J1939, CANopen, J1587

ISO11783 - CANoe

Aerospace options: AFDX®, A429, CANaero (now part of standard option .CAN)
Sensor (PSI5, SENT, SPI) - CANoe
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Main Benefits

» New Communication Concept:
» New graphical configuration
» Switching of endpoints (simulated, remote, measured)

» Ethernet
» TC8 Support
» TLS Support
» New hardware

» Testing
» CANoe comes with viewer version of vTESTstudio
» Export test reports to PDF
» VT System: New Switch Matrix Module

» New Option .Smart Charging — Standards:
» GB/T 27930 (China)
» DIN 70121/ISO 15118 (Europe, USA)

» Option .Sensor: SENT Piggy for VN1640A/VN1530
» No VT necessary for smaller projects

» Option .CANopen: New and completely reworked configuration

» Option .Car2x: New map window
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Communication Concept (CANoe)

» New graphical Communication Setup window as central place to configure the Communication Model

E Communication Setup - O X
Mvailable Elements bR =y @ gg & P E:'_' .-“EE o
ﬁ_ - -
El = | Endpoints, Participants and Application Models that can be used in CANoe: Mavigation Tree
<Search> H "| ~ {ay Home »
Simulated
‘c: = {g; v Partidpants » ‘ [:" e 4 {3 Home -
Mame 4 LIDAR Front 4 [0 Mirror Communication
= {2 Participants -
| Console
[ Badkend Simulated Smulated Smulated -
5[] Console |}.ﬁ imulate |::.)' imulate I::.)' imulate 7] Mirror_Driver
1-[] Dashboard Dlﬂ Mirror_Passenger
(-] Drive_Master Drive_Master )
(-] LIDAR_Front R Mirror
[J--[}"] LIDAR_Rear |::., Simulated r_ D-f] Backend
[J--[}"] Mirror_Driver D{ Dashboard
[J--[}"] Mirror _Passenger oo v
Properties
E Name Drive_Master
Mamespace Participants .
Start Values Drnive Master oo St O Simulated v
: 2 Communication Counterparts & Measurem W
Application Models
Generate C& AP
Active  Name Model
Dashboard D:\Programme\CANoe 12.0.61\CAMoe Sample Configurations\SOA\SOASystem‘\Application_Models\Dashboard. cs [, Qualification in Application Model + v
Drive_Master D:'YProgramme\CANoe 12.0,61\CAMNoe Sample Configurations\SOA\SOASystem \Application_Madels'\Drive_Master.cs B Endpoints in Parficipant ~
Mirror D:'ProgrammelCANoe 12.0.61\CANoe Sample Configurations\S0A\SOASystem \Application_Models\Mirror.cs B —¢ Services:Navigation[Drive_Master] X
< > Start_Values D:\Programme\CANoe 12.0.61\CANoe Sample Configurations\S0A\SOASystem\Application_Models\Start_Values.cs B —¢ ServicesObject_Recognition[Drive %
—  Services: Passenger_|nformation[C = X
ﬂ Data Sources Application Models % Validation Issues Comment w
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Communication Setup Window — Data Model

» Import of ARXML and vCDL (Vector Communication Description Language) files into the Data Model
» Edit the Data Model and create elements from scratch

B Communication Object Editor O *
by [~ = [ | {3} s Function Types | #F fae | () & Properties: Parameter
Mame Name MNamespace Result Com... Data Type Properties H ~
@ Communication Setup El-LH Type Definitions A | | Get_Navigation_Info_prototype DataTypes # | void - | ¥ 82 A Data Type v ¥
. §§ PDU Types AdjustMirror_prototype DatzTypes ¥| variable... = [# 5 Linear Encoding - ¥
Available Elements B PDU Timings Al bt DotTumenn (] ueid & Tl Textual Encoding - |#
| & T, Function Types _ & Parameters | 2P B | 3 Data Type Properties (raw) &
By Service Interfaces
| <Search= .77 Data Types Name Data Type Direction Optional Comment Data Type | # N
-, Encodings destination  String « [#in ~ | A IETE Linear Encoding - | *
o {ﬁ b Parti =33 Communication Objects longitude Double -~ [#|in " | | ¥ 8 Textual Encoding - ¥
%% PDUs — -
.. tion... " t E Data Type (min. fmax.)|L... ~
El{& Participants - [B} Services naviaaten o e 0 . |
: . W - qp Min. Value 0 W
[}r‘] Backend o Sinnals e .

[}‘ﬂ Drive_Master ]
-[] LIDAR_Front P
t-[~] LIDAR _Rear File

(] consol ok |[ el |[ oo |,
-] Dashboard Float
H Data Sources

Status
&[] Mirror_Dri
E‘% M?FFDF‘PWEF D:\Programme\CANoe 12.0.61CAMoe Sample Configurations\SOA\SOASystem\System_Description\S0A_System, wCDL @ @ &
- irror_Passenger
) . > D:YProgramme\CANoe 12.0.61YCAMNoe Sample Configurations\SOA\SOABasicAsrAdaptive WWRXMLCalculatorService . arxml @ E% &

ﬂ Data Sources Application Madels % Validation Issues
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Communication Setup Window — Communication Model

» Select elements from the Data Model that can be used in CANoe —> Communication Model
» The Communication Model is represented by the blocks in the middle
» Application Models are represented as well and can be grouped with other elements

@ Communication Setup —
Available Elements B iE s, i G Navigation and

w0 | A Endpoints, Participants and Application Models that can be used in CANee: Navigation Tree SRR

@'| ~ {= Home »

Simulated
|<3=l = {ﬁ b Particpants # | I}.] imuiate P fh
Name ’ LIDAR_Front 4 [ Mirror Communication
EI--{ﬁ Participants

: [ |

|}':| Backend = - — D'ﬂ onsole

|},:| Console I::‘il Simulated I}"] Simulated [:)/il Simulated [y] Mirror_Diriver
D‘ﬂ Dashboard [:f] Mirror_Passenger
t#l-[] Drive_Master Backend Drive_Master Dashboard ,

-] LIDAR_Front [E Mirror

-] LIDAR_Rear
|}':| Mirror_Driver

I}"] Simulated r_ D‘j Backend
; [#’] Dashboard
|}':| Mirror_Passenger
B{é Participarltsz LIDAR_Rear [ﬂ Dri'.'e_MaSLer

|}’:| Consumer [ﬂ LIDAR_Front

-] Provider @ @ @ [j-rj LID&R_Rear
. ) Start Values Drive. Master Dashboard Grou_ping of elements
) possible

ﬂ Data Sources Application Models % Validation Issues

T me . 3 s

Properties

hlamnm  hdirrar i mee e amim— e




Communication Setup Window — Switching of States and Measurement

VECTOR >

» State of Participants and Endpoints can be switched between Off, Simulation, Remote, and Measured

» Measurement Points allow measuring of point-to-point connections

Mavigation Tree

/2y Home »

4 {2 Home

4 [T Mirror Communication

Properties

Mame Dmve_Master

Mamespace Participants

Participant

] Esckens
[#] LIDAR Front
[#] LIDAR Rear
] Dashbond
Generate C# AP

<

Communication Counterparts & Measurement ~

W

Measure

R R AR

Symbel Explorer ax

e~ M=% B A

iid

G oo | MW Eve.. ¢ Obj.. » Walue » Dist...

Marme

!

= {ﬁ Participants
[}‘ﬂ Backend
[}"j Console
[}"j Dashboard
El[ﬂ Drive_Master
EI@ Mavigation
- % measure[Drive_Master,Backend]
EI@ Object_Recognition

= % measure[Drive_Master LIDAR._Front]
Elf% Events
=% Object
%'# Subscription State
=P o Value
' Classification

- % measure[Drive_Master LIDAR _Rear]

= @ Passenger_Information

H- ¥ measure [Drive_Master Dashboard]
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vCDL - Support of SOME/IP Binding Configuration

[version=1.0, serviceld=11]

service Calculator

{

void Add(int32 operandl, int32 operand2, out float result) [methodId=31];
void Substract(int32 operandl, int32 operand2, out float result) [methodId=32];
void Multiply(int32 operandl, int32 operand2, out float result) [methodId=33];
void Divide(int32 operandl, int32 operand2, out float result) [methodId=34];

[udpEndpoint="192.168.1.10:40000", sdMulticastEndpoint="239.0.0.1:30490"]

consumer Terminal;

Binding configuration can also

be separated from interface

[simulated = false, instanceld = 1]; definition

provider VC121; (e.g. multiple files)
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Distributed Mode

» Unified configuration for all VTP e et b .
devices | Vector Tool Platform - General
» All VTP devices can now be N A
configured independently of the i e Devlopment I 10
connection type (USB or Ethernet) .
» The connection in distributed mode e s
must now be explicitly defined vt e ST 1073WD

» There is a new button in CANoe i descrition
Ribbon for this purpose

Vector Tool Platform - Channel mapping

Channel mapping @
» Channel Ma p pl ng PR 4 HJ VN8970 (000060} ¥ Device (VNB970 (000060))
4 i FRpiggy 1080Amag Channel 3
. %= CAMNoe FlexRay 1 Transcieve LINpiggy 7269ma
» For all VTP devices the channel Date: 4 @8 CANpiggy 1041Amag (Highspeed) R Py
- - 1;2:;0“&: ;g C.ANGE CAN-I
mapping can now be done via the o NP T e
3 Channel 4
Platform Manager S0mes [ aaee | [cand
& On board CANalyzer r CAN 2
- - -t
» This works via USB (as before) as = el S
. . Shutdown delay time: FLEL
well as via Ethernet connection e comecin
&S eoan emo suppert Application ~ CAN LN FR  Eth DAIO AFDX A429 GNSS WIIP SENT
Save support information to local file s CANoe 2 1 1 i 0 i] 0 0 0 0
15 CANalyzer | 2 1 1 D 0 0 0 0 0 0
B CANape 2 1 1 0 0 0 D D 0 D

Connected: VN8311 (SN: 999989, IP: 1049 83 .52)
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Distributed Mode - Affected RT setups

VN89xx: Network interface
and simulation platform

USB or

Ethernet
VT60xx: VT board as
simulation platform

Ethernet
CANoe RT Rack: IPC as
simulation platform

Ethernet

VN89xx

CANoe RT Rack

VECTOR >

VTP dialog also replaces the standalone
manager

VN8900 standalone

VT System standalone

VT System
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AUTOSAR PDU IG for CAN, Ethernet & FlexRay

» New IG for AUTOSAR PDUs

VECTOR >

» Interactive, intuitive stimulation tool for AUTOSAR PDU based networks

» Available in CANoe and CANalyzer
» Manipulates PDU timings, triggers PDUs, changes PDU payload
» Full support of security & safety PDU features in CANoe (Secured PDUs, SQC, Update Bit)
> Famlllar WOFkﬂOW fOI" CAN IG UserS I&PDUInteracti'\.'eGeneratnr - O X
(SRR - I R P U
Row Trigger Trigger Settings Timing MName Length (Byte)
Penodn: 20 ms * Eventbased: 10ms - f{jEnngDaiﬁIEEE ‘
Dn SysVar update: MMTester::M... + Eventbased: Oms - f':tleagRequest Muotor
—— — =
Name Raw Value Raw Step Phys Value Phys Step Unit Start Bit 7 Length
Status 0 a v 1 Wakelp * 1 0 2
ErrorCode 0 - * 3 0 - v 3 2 6
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Diagnostics: Features and Improvements

> D OI P . ( [E5 Diagnastics/1S0 TP Configuration & ]

» Transmit “Vehicle Identification Dlstoseces Configure Diagnostios ver P Gateray
Req u est" a s I PV6 m u Itica st a n d a S u n ica St to B..E..ENDDUF F‘alaﬁmetelrs from Diagnostic Description regarding DolP/HSFZ
1 El‘_. Transport Layer Overmide manualy @
a dedicated address ol
L. [Fg Addtional Descri
» Choose whether the optional e i B e T g
IIVI N/GI D Syn C Statu Sll S h 0 u | d be Ez;?e[;:a:;to CAN IF_{:gu.t;ddreSf. | [‘mEED. D;D Hdapjer. [[Eth‘l]{IP\rG default) v]
. . BB Gw g activation type: =
sent by a simulation node " DolP Sz St |
L |

> "Legacy DoIP access" can be deactivated & Kine Log. address: 21000 2] Adapier:  |see node TCP/IP corfia.
] . . . | Lok COM , o
(deactivated by default in new configurations | e sstes vaose sengy Vel denfcaion Reauest Parsmete
. . . -5y 150 TP Observer Address: VECTORVEH1CLES100 © Format VIN
to avoid confusion when using VN56xx

HW interfaces)

Request As: I’ Mutticast to FFO2::1 h ]I

Vehicle Simulation Parameter

WIN: VECTORVEH1CLES100 EID: 03-04-05-06-07-08 GID: 08-07-06-05-04-03

[E3 Diagnostics/ISC TP Configuration
| [ send vin/GID syne status |
Diagnestic Access Configure Diagnostics over IP Main Settings Behavior when ECU closes connedionl}
Bty CAMN Metworks . Wait befors reconnect attempt: 500 = ms
© 5.1 CaN DolP/HSFZ Behaviour . .
H i D Interval between attempts: 100 | ms
&3 Door Protocol:  [DolP V2 (IS0 13400-22012) .

..... E-.L'_ Transport Layer Maximum number of attempts: 10

-G Diagnostic Layer [¥] Activate DolP/HSFZ interpretation @ 1 m b
B Addtional Descif Send (xFF as protocel version in Vehicle |dentffication Request messages OK ] [ Cancel ] [ Apply ] [ Help
=-T Ethemet Networks
E"i’i’ Eth1 I [7] Activate legacy DolP access I

» Improved data interpretation for OBD-II
» Support service 0x38 "Request File Transfer" in the standard diagnostic description (GenericUDS.cdd)
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LIN: Improvements

» The Interactive Scheduler now allows you to configure and send individual frames:
» Raw frames

» Frames from the LDF description

» The checksum model of the LIN-Reserved-Frames (ID O0x3e/f) can now be configured:
» Use function linSetChecksumModel

By imisc
¥ 2 (0] 8 & =

Network Frame Active FrameID DLC Send Type Send Trigger Frame Properties H
= ZE D [ ] ox0 8w Response Only + Manual - Name
Active
i Schedule Tables g MasterReq 0x3C 8 Response Only ~ Manual -
Frame ID |0x0
i [ Frames DLC 3 -
Send Type|Response Only -
Trigger Manual

Raw Data

Byte0 Bytel ©Byte2 Byte3 Byte4 Byte5 Byted Byte?
OxFF OxFF 0xFF OxFF OxFF OxFF 0xFF OxFF
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Features and Improvements (1)

» CAPL now supports parallel execution of multiple threads within one test case or parallel execution of
multiple test cases within one test sequence

export testsequence TestDoorLeftRight () [ES Timeline [0.502811 .. 1.002811] X |9 -
{ 0502811 %, ParallelTests [1 _ 2] Start :
dword tecDoorLeft, tcDoorRight: API to start parallel )
q q 4 Main Part
execution in/of test cases .
RezetSignals(); a 0.502811 3l Test doors [1 . 2] Start
=1
p=]
0 4 Main Part
tcDoorleft = testStartParallel (TestDoorLock, "left", LockRequestLeft, LockStateleft):; =
tcDoorRight = testStartParallel (TestDoorLock, "right"™, LockRequestRight, LockStateRight): - 0.502511 HEEiEl IS
: 05025811 B& 1. Test door left: Start
testWaitForAllParallel (1000} ;
4 Main Part
i . . q Request to lock door left
ResetSignals(): API to wait for one, multiple or Wt =
testcase TestDoorLock (char side[], signal* sigLlockRequest, signal#* sigLockState) < LR
i 0502511 Request to lock door right
o, B Test Trace - 0O X 1.002811 Waited for 500 ms.
} S
B 4 [ Ver At | <Search> &L B REA 1.002811 Door left is not locked
S Time Action ledict 1.002811 B 1_Test door left: End
e [} 0.502811 Test configuration started: Door Lock Tests
g ----- a 0.502811 Test unit started: ParallelTests 1.002811 Waited for 500 ms.
""" +-] 0.502811 Test sequence started: Test doors o
----- e 0.502811 Reset all signals 1.002811 Door right is lecked -
""" <o et ot e om e
- e 0,502811 Request to lock door left
= . . 05011 Start wait for 500ms . + o2st1 Reset all signals
Visualization of parallel threads PR #55] 0.502811 Test case started: TestDoorLock ' : 2
in the Test Trace Window ----- e 0,502811 Request to lock door right 5 Test doors [1
H |2 e 0,502811 Start wait for 500ms
PR e 1002811 Door leftis n.ot locked fa!l 1.002811 %, ParallelTests [1 .
""" v 1.002811 Test case failed: Test door left fail -
----- e 1,002811 Door right is locked pass
""" +| 1.002811 Test case passed: Test door right pass
----- e 1,002811 Reset all signals
""" + /L0051 Test sequence finished: Test doors . Visualization of parallel threads in the
----- 1.002811 Test unit failed: Paralleests fail . ) N
----- 1.002811 Test configuration failed: Door Lock Tests fail Timeline of the Test Report Viewer
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Features and Improvements (2)

VECTOR >

» A viewer version of VTESTstudio is now part of the CANoe installation and available as free
download as well; thus, no vTESTstudio license is needed anymore to open and view VTESTstudio test

designs

» When using numeric system variable as field codes for the test report name the precision of the
value can be specified now; the precision specifies the number of string characters or the number of

decimal places

All Tests - Configuration

=

Start / Stop Event
Excecution Options

Additional Report Information

Test Report

| Create joint test report for all test units

-

Mext test run: |1

-

Output Options &

Test report path:

4Noe_Corfiguration Report_MotorTests_Ei@Voltageld} estrepor] | | | Field Codes

-

Example: CA.. CAMNoe_Configuration\Report_Motor Tests oo vtestreport

» A command line interface for the Connection Utilities allows continuous integration with Jenkins;
a Connection Utility is available for free for IBM DOORS NG/RQM, Siemens Polarion ALM and PTC

Integrity
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Features and Improvements (Report Viewer)

Start

rpt9739 (Test is runni

Filter

I Open PDF Export
Recently Used E:%
Print Export
PDF
Export
Settings
IO () Export current view
(@ Export entire Test Report
Help
§F Options ﬂ Portrait
& support ﬁ US Letter
85x11in

B Exit

Open exported PDF file

» Export to PDF

» Create navigable and searchable PDF file
(since 11.0 SP3)

» Structural elements can be navigated

» Many referenced elements can be used for
navigation as well

» Run & analyze test in parallel

» Reports in the Report Viewer format can now be
opened, viewed and analyzed even during test run

» Update of current report is done by dedicated user

action
Perform update w
BB S B - rpt9739 (Test is running in CANoe) - Vector CANoe Test Report Viewer

Start Filter

=) i A of 02 Jaew
- -| & Impc
Owerview Table of Show Backward Forward = Test Cases Trace ltems = MNew -
Contents | in Tree - . by Verdict by worst... -
Mavigation Query
Explorer ~ || = Central locking syst..m test [1. 2] X ||£I|
g |
=¥ 4 [ Central locking system test [1 .. 2] (7]
B Test static requirements of the...
2 = “ ® Test Case Results
= oy
Fail 0 | 0%

Test is running in CANoe. Report is incomplete!

General Information
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VT2832 - Switch Matrix Module

Use Ca Ses = v -0 =5-H 3 B - Configuration1 * [VT System Control - M2_Ch2] [Real Bus] - Vector CANoe - O x
C t t h . & t Home Analysis Simulation Test Diagnostics & XCP Environment Hardware Tools Layout ~ @ - X
» Current switching measuremen ﬁ % E ﬂ ED '_ﬂ @ - - ab
& D M B o
> PW M SW I tCh I n g / bo u n CI n g cl_'l-lsaangn:I 51:‘;;?% I—r;JaErtc‘ﬁ:E:kE H:;full-'i:re Configurstien CDIjtFEd TD'D - CoErﬁZTr?gon "!'?IIE%J ) Cnnﬁiﬁ?ﬁﬁon Con:gjfrc.laﬁon Other
CO n ta Ct S| m u I a t | O n Channels VT System Sensors IfO-Hardware
VT System Overview ¥ Interactive Schematic View | i |
» Endurance Tests e e ~lean=E e =)
- - -~ M2_Chi o Channel Functions
Conflguratlon ~ [ Output Settings
:;_E:i g . : - - Curve Type Constant -
» Each switched path is given a vachs P99 9 0DO0D - e
. - M2_Chi o Q0 O OO0 Qo Qo0 Q0 QO . .
unique colour o - 20 20 20 Q0 g 20 Stop Stimulation Siop
- M2_Ch3 i B 5 & (I:' (IJ o) O O (5 PWM / Bitstream Output Mask
» Connected paths are given the ) " | | Row 1 O
: B—C0—0 L L Row 2 [
same color R2 | ] ]  Rows B
_ i BO—0—0 990000 1 rows B
» Each column can be switched o | | :
. . B -y O———— O ————0) ¥ PWM Output
Independently Wlth PWM or R4 Frequency 00H:z
b ItStrea m o Q Cl) 2ut~_.r C;rcle 0.0 »ﬂo
o}7 Om Oh =
» PWM and bitstream IO et Deley oo
. . . . . [ : ] L Bitstream Qutput
configuration is identical to - Mone
other VT System modules Parsmeters
Trace - Configuration - Analysis - g q I
oW 0:00:00:00 -
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Inter Board Communication (IBC) between User FPGA Modules

OutputVT2710  IBCV...

Use Cases R I = =" IBCDemo - VT System FPGA Manager - 0O x
Fi|E Home ~ @
» Highly synchronized output of analog 2 & s B > R A = W
a n d/o r d ig ita | S i g n a IS Erxoﬁzg: PII-n;]pEocr;S Refresh o;DED?::\?e Edit Contents  Compile  Test  Persist Dlhogar:::e Sho'A;:':;e;come Clssgg:er Configuration
Workbench rojec ore
» Fast data exchange between User FPGA ijectmlo:r = : 5
m Od u Ies ::‘: i T Project Comment
4 [ Multi Module Projects Comment: |Todo: enter your project comment here
4 T IBCDemo . -
.- 4 CvT004 Multi Module Project Setup
Realization T 1BCVT1104 — v
T 1BCVT2004
- - nter Board Communication
» Ring architecture between User FPGA Seeos || [See =~ _ Enabler Check Box
p rocessor boa rd S -.g igzgiz Communication master: | IBCVT2816 v Re ce ive r M atri X
b lm m Signals: \
r’_ I MultSimuink Sgilgnal Settings Readers
: r— E;EE:: Mame Writer  IBCYT1004 /7110 T200 T T 0 ] 343
g OutputyT1004  TBCV...
v B wT2816 OutputVT1104  IBCV...
y B0 vT2848 CutputVT2004  IBCV...
v B vT79008 OutputVT2516  IBCV...

» Simultaneous flashing of multiple
VT System User FPGA module is now
possible in VT System FPGA Manager

EEEEE

OutputVT2816  IBCV...

(<]
HHHHHH <k
HHHHH S
HHHH saef
HHH SISISIC)
HH SRIEICE] *

L.

IBCVT1104

IBCYVT2004
IBCVT2516
IBCVT2710
IBCVT2816
| IBCVT 2348

—— Sender Dropdown
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Improved VT System Configuration Dialog

» All regular and application specific VT System
modules are now grouped in a clear way in the
VT System Configuration dialog

» Support for new 60V variants
already included

» V11104 Load and Measurement Module (60V)
» VT7101 Power Module (60V)

[Tl VT System Configuration

Configuration ~ || Module ~|| Hardware -

Configured Mody Rename F2
M1VT1104 |

iodule selected
Add >

L

| & Add Application Specific  » VT7900 with Application Board

WT7900 with VT7820 - Rotation Encoder Module
WT7900 with VT7870 - Smart Charging Module

=  Remove

=  Remowve All

gl=  Set All Modules Online
g+ Set &ll Modules Offline

User FPGA Enabled Modules

WT1004 with VT10044 Demo Simulink’ user FPGA extension
WT2004 with VT2004A Demo Simulink’ user FPGA extension
WT2516 with WT2516A Demo Simulink’ user FPGA extension
VT2816 with WT2816 Demo Simulink’ user FPGA extension
WT2848 with VT2848 Crank Cam FPGA' user FPGA extension

(! MT System Configuratio

Configuration -

Module ~| Hardware -

Configured Mody

Rename F2

VECTOR >

1le selectad

(& Add

»

dr  Add Application Specific
= Remove

= Remove All

= Set All Modules Online
Set All Modules Offline

i

»

VTlooo

VT1004 -

- Load And Measurement

Load And Messurement Module

VT1104 -

Load And Measurement Module (60V)

VT oo

VT2004 -
VT2516 -

Stimulation Module

Digital Module

VT2710 -

Sensor Module

VT2816 -

General-Purpose Anslog 10 Module

VT2820 -

General-Purpose Relay Module

VT2832 -

Switch Matrix Module

WT2848 -

General-Purpose Digital 'O Module

VTeaook -
VTE104 -

Metwork Interfaces

Metwork Module

VT6204 -

Metwork Module

VT6306 -

Ethernet Network Module

VT 700 -

VT7001

Power Supply

- Power Module

VTT101

- Power Module (60W)
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AMD/XCP: Feature Improvements

» New columns for parameter type, min, max and unit (CANoe 11.0 SP3)

VECTOR >

B xcpfcce
244 B E&EE I i)
Mame Configured Mame Auto Read
= E Xcpsim W period
E S Y “& ampl
- MG DAQ £ channel3
£ channel2
% testString
%, gTimerDrift |:|
| % timeFactor
|:| £, TestWord_999
& of 1233 configured, auto read: 5

Measurement

DAQ
DAQ
DAQ
DAQ
DAQ
Polling
Paolling
Polling

Cyde [ Event

10ms
10 ms
10ms
10 ms
10 ms
100
100
100

ot

Value
0.000
0.000
0.000
0.000

Ox0

el Sl
=
EFE$YTR

&= 16| 16

Data Type

Float
Float
Float
Float
UByte
SLong
Float
UwWaord

Min
o}
0
-100
-10000000...

Max Unit

100

200

100
100000000, ,
255

10000 ppm
20
255

Comment

Period of channel 1-3 ~
Amplitude of channel 1-3

FLOAT demao signal (sine wave)

FLOAT demo signal (sine wave)

e

Timer drift for ECU time stamps

ECL dock factor (time master)

» The XCP Master Port can now be configured for XCP on Ethernet connections

(=] Protocol Settings

Response Timeout [ms] 2000 1
TCP TP Transport Layer upp 1
Host (IPv4, IPvE or Computer MName) 192.16&1:
Host Type IPv4 1
RAM Page Switching False
Connect Mode (hex) 0x0 1
Check EPROM Identifier from Database False 1
Optional Commands Default 1
[= DAQ Settings B
Use DAQ time stamps of ECL False
DAO Timeout [ms] 2000

Port Settings
Slave Settings
P )
o 1
Master Settings
Cancel

>l
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Scope: New Features

» With CANoe/CANalyzer 12.0 it is possible to switch between

» Several scope hardware configurations - means users can predefine several hardware settings which
can be activated for each measurement

» Hardware configuration capabilities are available in GUI and CAPL

Scope Hardware Configuration

Active Configuration: | Config Picobcope 5444B-034_UserDefined (| gh § )
Scope
Device type: | PicoScope 5444B-034 - oltage resolution: |12 Bit -

Measurement channels

Channel Signal Source Label Probe Range Scope Range Signal
A CAN1_H - x10 200 W a W

B CAN1_L x10 200 mW oW

C Mone - -

b Mone - -

Extern Trigger - -
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Sensor: SENT Piggyback

» New SENT Piggyback

» Supported Network Interfaces:
» VN1640A and VN1530 (PCIe Interface)
» Drivers already released

ﬁ Sensor Configuration

&, Vector Hardware Config

== g
Configuration = Channels » Hardware Configuration...
Sensor Channels Mode SENT Channel Settings
= L4 sent
S5 Assigned hardware channel: |SENT1 hd
-5 Ecu = Real
E‘"E.' Sensor A Simuiated Simulation Settings: Stimulation Data Source 4l
“w Signal 1
(=G Channel2 (SENT2) Logging file used for sensor/ECU stimulation: D
2 Ecu i+ Simulated
=1+ 5 sensor = Real
L Signalt

Application License Support Help

= Hardware +  Detais =
B Vitual CAN Bus 1 | e pevice V1640 1 (000452)
2 VN2B00 Channel 1
&’ WN1E301 Software time synchronization Stopped
26 VN164D 1(000452) On bus HO
Tianscsiver SensorFigay SENT
= ChNoe SENT1 ~Hardware revision 1
=48 SensoiPigoy SEMT B Description
e CéNoz SENT 2 E
AR} CANpigay 1057Gcap (Highspeed] # Assigned applications:
4B CANpiogy 1057Goap (Highspesd) | | % CANoe SENT 1
22 On board D4 10 1021 i i
- WEE101 @ D-SUB9 Pin Assignment
e 1630 log Connector CH1 |
~akg Netmork Devices E:: 12
T Application . RNa GND
&, Global Settings PIN 4 .
= @ Driver status - FING ;I

(RIS

ey

VECTOR >
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CANopen: Configuration Window

New CANopen Configuration window replaces ProCANopen and allows analysis, configuration and
simulation of CANopen networks

» Scanning of CANopen networks S Catlopen Confguraton -0 ox
. . RE2EARBE R @
» Access of the entire object o
. . 8 Mame MNode ID General Object Dictionary
d |Ct| O n a ry Of rea I a n d SI m U Iated = !'f“gmpe” Object Dictionary of ControlPanel ID 10 Name COB-ID SYNC
[+ 22 ControlPanel o .= ox evice Type ~ ndex 0101
( CA N o€ ) no d €s E- SupportRear 13 . Ex iEEUI Error Rn-ar;iZter ;LITJ Index ;X;JJS
'E- LadderDrive 11| | |5 0x1002 Manufacturer Status Register Object type Var
» Setup of PDO and SRDO 28 supportfront 12| | o T | | oo oo T
commun Icatlo n i B Master 11| %= 0x1006 Communication Cyde Period Access type R
- #= 0x1007 Sync. Windaw Length Mannable
. . - 0% 1008 Minufﬁct.lrer Devgilce Mame rLLplim': 0x80
» Configuration of Heartbeat -5 0x1009 Manufacture Hardware Version || [, i
m O n |t0 rl n g _t: Ex 1222 !anudf—:-:fmrer Software Version Object flags 00
-5 0x100D Life Time Factor
» Read and write the entire network D ettt et
con fl g u ratl on [ 0x1016 Consumer Heartbeat Time Mame Mew value Current Value Default Value
- 0%1017 Producer Heartheat Time SYMC Producer Il
H [}ﬁ 01013 Identity Object Raw Value 0xB0000030 0xB0000030 0xB0000030
» Generation of CAN database 5 01200 GENERATED N
. . . [};i 0% 1400 RxPDOComPar CAM ID %20 %80 %80
» Creation of simulation nodes for a -8 01401 RAPDOComPar
. . | G- 0x1402 Receive PDO Communication ... |
network simulation (CANoe)
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TLS Support for ISO15118

» Analysis of Transport Layer Security (TLS) communication in Trace Window
» When either charging station or vehicle is simulated

SR ETE R K [F 0 At li_@:|€ <Search> B8 e =i | B - B- A D~ [0 Inital -

D Prot... Mame Protocol Info Source IP Destination [P Packet...
tep FESF -= CTAT [ACK] 5eq=9017781F Ack=B259657... FE80::2 FEBO::11 85
s TLS 1.2: Handshake 123
tep FESF -= CTAT [ACK] 5eq=2017781F Ack=B25965A, .. 85
s TLS 1.2: Application Data 183
v 20 Supported App Protocol Request Mo information TG
tep C7A7 -> FESF [ACK] Seq=B25965A2 Ack=3017783... 86
= tls TLS 1.2: Application Data 119
=l w2g Supparted App Protocol Response (OK) No information 12
5] tep FESF -= C7A7 [ACK] Seq=90177B80 Ack=B25365C... 85
/= tls TLS 1.2: Application Data 136
- = vag Session Setup Request TP version: 1, Session ID: O 29
/= tcp C7AT -= FESF [ACK] Seq=B25965C3 Ack=20177BE... 85
5] ts TLS 1.2: Application Data 152
- (=l v2g Session Setup Response (OK) TP version: 1, Session ID: 1IFFE2525A4AT6D28 45
/B s. tcp FESF -= CTAT [ACK] Seq 90177882 Ack=B2536605... 85
0= 2. ts TLS 1.2: App 145
H-E 9.120076 vag Service Discovery Reguest TP version: 1 D: 1FF&2525A4A 76028 38
tep C?f-\? - FESF [ACK] Seq 82596605 Ack=30177BE... 85
s TS 1 L 187
v2g Service Discovery Response (0K) TP version: 1, Sss-s- on ID: 1IFFG2525A4ATE028 B0
tep FESF -= CTAT [ACK] Seq=90177BED Ack=B259664... 85
s TLS 1.2: Applicatior 130
Wag Service Detail Request TP version: 1, Sess FFE2525A4ATED 25 23
tep C7AT -> FESF [ACK] Seq B250666A Ack=30177C1... 85
""" = 10 I'Zl"_'_S ts b 173
- 10.020115 w2g Service Detail Response (OK 66
1 m

Payl...

La
=]

=]

Ly o

=]

=
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Simulation and Test of GB/T 27930

» New GB/T 27930 Interaction Layer (GBT27930_IL.dIl)
Easy to use, minimal configuration effort

>

v vyvyy

Simple control during measurement via CAPL

Various options for fault injection
Direct access to the simulated node from a test unit

Requires Option .J1939

@ BMs

= Delay change to... (ms) +

BHM 1200
BRM 1800
BCP 2300

BRO (NotReady) 1123
BRO (Ready) 4500
Charging 3200

Handshake / Configuration | Charging I End of Charging I Inte

Handshake (BHM)
MaxChargingVoltage (V) |120.0

Recognition {(BRM)

m

‘»E]u

m,
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a Charger
. Delay change to___ (ms) o

CRM (Mot recognized) 2100
CRM {Recognized) 3500
CML 1000

CRO (Mot ready) 1000
CRO (Ready) 1000
Charging 1000

L’,} Trace filttered
6 S EZ %&9% 8 At <Search> - @ @}
§ PGM Mame Src Dest DLC J1939 Interpretation
g 0.367388 2600p  CHM 56 F4 3 Version 1.1
g 0.368356 2700p  BHM F4 56 2 Max. output: 120.0V
0.369576 100p CRM 56 F4 8 BMS is not recognized (Charger Mo. 0x0, location 'ABC")
0.375528 200p BRM F4 56 49  Cobalt based lithium battery (110.0 V[ 43.0 AR)
0.619560 100p CRM 56 F4 8 BMS is recognized (Charger No. 0x0, location 'ABC')
0.622312 &00p BCP F4 56 13 S0C: 10.0 %; current voltage: 80,0V
0.623556 800p CML 56 F4 8 Qutput: 20,0V to 150.0V, 10.0 A to 120.0 A
0.624316  900p BRO F4 56 1 BMS is not ready for charging
0.874308  900p BRO F4 56 1 BMS is ready for charging
0.875316  AOOp CRO 56 F4 1 Charger is not ready for charging
1.125312  ADOp  CRO 56 F4 1 Charger is ready for charging
] | [

Revision Version El [ Simulation Setup

BatteryType [Cobatt Based Lithium Battery (5) v |
C ity (Ah) 43.0 Voltage ( 1100

apacity (Ah) - g= (V) - ECU ECU
ManufacturerName |£1 &2 &3 &4 abed BMS Charger
BatteryPackMumber GBETEEES GET27930 IL GBT27930 IL

ProductionDate({ YYYY MM DD)
7272

ChargingFrequency

Property [Existing On Vehicle (1) ']

VIN 61 €2 63 €4 65 &6 |abedef
&7 €2 &5 &h &B &C |(ghijkl
€D €E &F 70 71 mnopq

Software Version
SenalNumber

CompileDate (YYYY MM DD)

P VR, V.Y, Y

4 | 1 3

JER g EE

MNetwork
GBT_27930
CAN1

2

4 | 1

Y, GBT_27930_2015 |

Handshake/Configuration | Charging | End of Charging

Handshake (CHM)

Version .

Recognition (CRM) =
ChargerLocation 41 42 43 |»BC
ChargerNumber ]

RecognitionResult BMS is recognized (A2 -

Maximum output (CML)
MinOutputCurrent (4)  [10.0
MaxOutputCument (4)  [120.0
MinOutputVoltage (V) [20.0
MaxOutputVoltage (V) |150.0

Send+ime syncronisation (CTS)
ChargerTime {YYYY-MM-DD hh:mm:ss) B

Output ready state (CRO)

ChargerReadyForCharging | Ready (AA) -

4 T | 3
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OPEN Alliance ECU Test Specification (TC8)

VECTOR >

» As of version 12, CANoe .Ethernet includes a configuration for running the OPEN Alliance test

specification for Ethernet controllers

TCE_Test_Configuration EH
» The tests covers mostly OSI/ISO layer 2 to 7 b BE |<sach> xvBBE £ x| mMaP-SE-
Title werdict Runtime
» The test procedure and the test definition are completely (®(%, TCE_Test_Carfiguraton ® 1585 +
H : : H f;}a ARP_Testcazes & 1,154 =
disclosed and can be adjusted with the help of vVTESTstudio 9 108 a0 Pt Fe. iy
. . . . . = [T]E DHCP_Testcases
» The configuration does not require extra licensing F o
. . . . . = [ ICMP_Testcases ] 0947
» A simulation of the DUT (Golden Device) is included, too ) ICMP Tests ) 0343
[ 1Pv4_Testcases & 1060s |,
Test Group CANoe 12.0 |CANoe 12.0 SP2 - W) IPvé Tests () 1060
yrt | Physical Layer T o
TC8 Switch Tests v v [}Da IPvd_futaconfig_Testcaszes (7]
m [ TEP_Testcases (7] 10951
s ! ARP v v £)/Hi) TCB_TCR _Testeases ® 10,951
ICMPvV4 v v & [V]l] TCP_BASICS_O7 ] 0.000=
| TCP_BASICS_02 @ 0.000s
Layer 3 | IPv4 v v +[71121 TCP_BASICS 03 & 0.000s
Dynamic IPv4 Link Local Address v v &2 [ TCP_BasIcs_04 @ 0.000
- ¢ L[¥]l] Send SYN @ 0.000s
UDP v v LGl Send FIN & nonts =
Laver4: TCP v v Wariant properties profile: [Default] - & I e
- Marne Walue Data Twpe Tesk Units Dependencies
DHCPV4 \/ J = TEPriuritr MY Integer [MAY, 5... ARP_Testcases none
Layer 7 — SOME/IP Server v v ‘- ARP_Testcases MaY nane
SOME/IP ETS v SR 000015 rotpassed 0
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New Features of Ethernet Interfaces

» CANoe .Ethernet is prepared to support the upcoming features coming with the release of the new

Ethernet interface firmware

» All new Ethernet interface configuration procedure
> External configuration, interface configuration is not necessarily part of CANoe configuration
> and configuration of the hardware is independent of the tool and can be used across-the-board

» Direct link between the each simulated node and interface hardware
> Improved topology related stimulation without topology dependency in CANoe

» Improved network representation/handling in CANoe compared to former application channel
representation of the network
> Support of multiple “"paths” to one network

» Changed measurement concept from “view all” to “view only what is of interest” to leverage
computing resources
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New Features of Ethernet Interfaces (cont.)

Computer A

Simulation Setup Network A

Computer B

Trace Window

Traffic Port Traffic Port

~ECU A" ~ECU B"

Ethernet Interface

ECU C

ECUD
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New Features and Improvements

» Map Window

>

>

v

vvyvVvyy

New control, more modern look

and feel

Intersection visualization based
on SPaT and MAP message

Support of fragmented
MAP messages

Visualization of Waypoints
Improved filtering mechanisms
Caching of map tiles

“Zoom to fit” button

Map Window

BE || q

<k ITS Stations

3

[ i
O T

Show

@iB

RoadSideUni. ..

Mame Node
[k Roadsidelni...

PassengerC...

(%)

[<f<N<| =

&2

ilifulE

’ ITS Events

Show

Mame

Intersectio...

Originator
RoadSideUnit 30

Intersectio...

RoadSideUnit 31

Intersectio...

RoadSideUnit 36

<<= =

Intersectio...

RoadSideUnit 35
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=By By
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>
o

i)

o
WOB wash
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New Features and Improvements

» Application Messages
» Car2xSystem Demo supports the latest CAM/DENM/CDD version (due to EU delegated act)
» System Demo contains intersections with SPaT/MAP messages

» VN4610
» Supports DCC (Decentralized Congestion Control) in order to send messages prioritized
» High precision timestamps are now supported

» Car2x Network Explorer
» Shows the value table of the data elements of application messages
» Improved CAPL code generation for the data elements with copy-paste operation

» Scenario Editor
» Nodes and attributes in timeline can be expanded/collapsed
» Child attributes are supported now

» Security
» Supports Request / Response mechanism for ETSI EN 103097 version 1.3.1
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J1939-82 Compliance Test (Revision 2015, CANoe)

» Tables A3 - A8 and A10 are fully implemented 7 - @ EF-HE B crdRelbul vecorCAtoe o — O X
. . . . Analys  Simulat  Te Diagnostic Enwvironme Hardwa Too Layo o \B_EJ
» Simple configuration, detailed and o [4] ~
easy to understand interpretation; e
» Individual protocol blocks can be tested, e.g.:
. . J1938
» Address Claiming / Commanded Address
» Name Management @ @ @
- 11939 1ch 11539 2ch J1939-82
> Tra nSpOI"t PI"OtOCOl New . Camﬁzl‘ij_%nlc;Test 2
W
» Request / Response
[ 11939.CT_configurater g, vTeststudio Projects
DUT PG with known data (DLC>E)  TOOL g B = RAF-S6- =
Address (nexl: _=§$a;ﬁjg::::55 Msg Tol 2bs_ms1- 2@ fhex: - Tool Address [nexl: Tite Verdct  Runtime
NIME [hex] - W [/ DML indicases Adar viel. Msg.Tol.Rel.: |0.10 DATA [hex] DEBUG [¥]5 VTestStudio Projects (7]
ECH= — 02 50 41 52 54 31 22 . [O] conrre [ TEST éla J193% Compliance Tests Rurtime @
. — Ser—dmiesp_ ——— .RTF:TI:IF-;_: 22 :i zi Z: 2; 2a s0 RIEPERELTPER [[] ceECRS E-%ﬁiﬁbtllo:?‘li}an;e Tce:t Tables 7]
Nr. EGN [hex] DLC>8 - Req. | oo e || e || s Momres ] prime Praconaizions .a' T:H:Aa (interactive) g ‘
IZ 1 00000 = 10 [F [ (= [ [¥] Brint Strategy |
2 oFCC1 D 1000 D D I:‘ I:‘ Inconclusive 2= ..g I:E::x g
3 OFEER o D D I:‘ I:‘ g [Inccmclusive - a Table A6 6 ‘
4| oFEsC Bl 50 Bl Bl [l B PART I TEST &) Table A7 ©
5 OFCB2 o [ [l [ m i i f: ; f [¥] 2utostart Test
I:l D I:l I:l D D ku'tostap HMeasurement ..a Table A2 @
& oo400 z0 7 Full mode
7 LT El 100| [ | [ = [l
. O ol O = 0 | ] - e
00:00:00
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J1939

» Convenient CAPL functions to support J1939 Diagnhostic Messages =0 %ﬁﬁf;g'é;;ﬁing
e unctions
» Assembling DTCs from their parts (SPN / FMI / OC) = %gpefgcmcpumnﬂmﬁ
. . . . """ INE rarameter \aroups
» Splitting of DTCs into their components (SPN / FMI / OC) E Aocess PGls o Database Hssages
- Enerd
» Filling diagnostic messages with DTCs % Event Procedures
. . . =I-\[] Diagnostic Trouble Code (DTC)
» Extraction of DTCs from diagnostic messages - [3] 11333G=tDTC
. . . - [2] J1935GetFmiFromDTC
» Test Feature Set (CANoe): waiting for diagnostic messages §-----%J15353etmum0fmcs
1 1 1 i | 2] J1939GetOcFromDTC
with any combination of SPN / FMI / OC g_____%mgmspmmm
i | 2] J1939Make DTC
» New CAPL functions for fault injection (CANoe) () 41939 InteractionLayer
. . - [2] J1939 Interaction Layer
» Delayed reaction to received messages - mzmmemcﬂm Layer Error Codes
. . . =1-A[ Functions
» Manipulation of any received or sent messages L@ oo
» Direct access to the simulated node from a testunit | = 7] J19391L Block RMessage
R A [ 2] 119381 Block TxMessage
» All J1939 / 1SO11783 Interaction Layers supported | . 7] J1939IL DelayRcMessage
J1939 2] 119391 ManipulateMessage
S A E J19331L Reset AllBlocked RxMessages
> ISO11783 e %J'I535ILHeseﬂ-'-.IIEInckedeMessages
. T SR [ ?] J159351LReset All Delayed FxMessage
> Vlrtual Termlnal ----- E J13351L Resat AllManipulated Messages
> Task Controller e 7] J1939IL ResetBlockedRxMessage
N SR RN E J19331LResetBlocked TxMessage
> File Server 2] J1939IL Reset DelayedFRxMessage
e E J19331L ResetManipulatedMessage
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ISO11783 (CANoe)

» New File Server Interaction Layer (ISO11783_FS_IL.dIl):
» Easy to use, minimal configuration effort
» Simple control during measurement via CAPL
» Various options for fault injection
» Direct access to the simulated node from a test unit

» Tractor Implement Management (TIM):
» Implementation of the latest specification (FDIG 1.01)

» TIM Simulator: all specified functions and facilities can be controlled and monitored via dedicated
panels
> 32 Aux Valves
> Rear and Front PTOs

Rear and Front Hitches

Vehicle Speed

External Guidance

VvV V V

» Improvement of Task Controller Interaction Layer (ISO11783_TC_IL.dll)
» additional CAPL functions to verify the structure of a device description
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Main Benefits

» New Communication Concept:
» New graphical configuration
» Switching of endpoints (simulated, remote, measured)

» Ethernet
» TC8 support
» TLS support
» New hardware

» Testing
» CANoe comes with viewer version of vTESTstudio
» Export test reports to PDF
» VT System: New Switch Matrix Module

» New Option .Smart Charging — Standards:
» GB/T 27930 (China)
» DIN 70121/ISO 15118 (Europe, USA)

» Option .Sensor: SENT Piggy for VN1640A/VN1530
» No VT necessary for smaller projects

» Option .CANopen: New and completely reworked configuration

» Option .Car2x: New map window
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For more information about Vector
and our products please visit

WWW.vector.com
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